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• Policies received. The last time the Parallels Mac Client downloaded its policy. 

• SCCM Proxy URL. The URL of the computer where the Parallels Configuration Manager 
Proxy is running. This is the Parallels Configuration Manager Proxy with which this Parallels 
Mac Client is registered. 

• Site code. The code of the Configuration Manager site to which this Mac is assigned. 

• Unique identifier. A globally unique ID assigned to this Parallels Mac Client instance. 

• Version. The Parallels Mac Client version number. 

5 The buttons at the bottom of the window are: 

• Connect. When clicked, connects to the Parallels Configuration Manager Proxy and 
downloads the latest policy from Configuration Manager. For more information, please see 
Initiating Policy Retrieval below. 

• Send Problem Report. Click this button to send a problem report to Parallels Support. For 
more information, please see Sending Problem Reports from Parallels Mac Client below. 

Initiating Policy Retrieval from a Mac 

Parallels Mac Client downloads its policy from Configuration Manager on a schedule. There may be 
a need to download the latest policy before the scheduled download occurs. Parallels Mac Client 
provides you with this ability. 

Using the Client Properties Dialog to Initiate Policy Retrieval 

To initiate policy retrieval: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Connect button to initiate policy retrieval. A text will appear next to the button 
informing you of the progress.  

3 If the connection to Configuration Manager was successful, the text will say "Connected" and 
will specify how many policy updates have been received.  

4 The Policies received property in the General list box will be updated if at least one update 
has been received. The property will remain unchanged if no updates are available. 

Initiate Policy Retrieval from the Command Line 

To initiate policy retrieval from the command line, open Terminal, change directory to 
/Library/Parallels/pma_agent.app/Contents/MacOS and type the following 
command: 
$ ./pmmctl get-policies 

On completion, the command returns one of the following XML documents depending on the 
result. 
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If policy retrieval failed: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>3</integer> 
        <key>ErrorMessage</key> 
        <string>Operation timed out</string> 
    </dict> 
</plist> 

where the <integer> element contains the error code, and the <string> element contains the 
error description.  

If policy retrieval was successful: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>0</integer> 
        <key>ErrorMessage</key> 
        <string>No error</string> 
 <key>NumberOfPolicyUpdates</key> 
 <integer>5</integer> 
    </dict> 
</plist> 

where the <integer> value of the <NumberOfPolicyUpdates> key contains the number of 
policy updates retrieved. 

To obtain the list of possible error codes with descriptions, use the following command: 
$ pmmctl error-info 

The command returns the following list: 
0: No error 
1: Invalid command 
2: Operation failed 
3: Operation timed out 
4: Connection aborted 
5: Unknown error code 5 

Sending Problem Reports From Parallels Mac Client 

If you are experiencing a problem with Parallels Mac Client, you can obtain a problem report and 
then send it to Parallels Support. To obtain a report: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Send Problem Report button to obtain a report. The Send Problem Report dialog 
opens and the report data gathering process begins.  
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3 Once the report file is generated, a message is displayed in the dialog specifying its location on 
the local hard drive. Clicking the Send button will send the report to the Parallels Configuration 
Manager Proxy, which will notify the IT administrator through the Problem Monitoring utility (p. 
151). The Problem Monitor can then be used to view the report summary and to send it to 
Parallels Support. 

The problem reporting utility can also be run from Finder as follows: 

1 Open Finder and navigate to the /Library/Parallels/ folder.  

2 Locate the pma_agent.app package, right-click it and select Show Package Contents.  

3 In the package, navigate to the Contents/MacOS folder and double-click the 
pma_report_tool file.  

4 The Send Problem Report dialog opens. This is the same dialog as the one that opens when 
you click the Send Problem Report button described above. 
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The Configuration Manager Admin Console 
Parallels Mac Management for Microsoft SCCM extends the Configuration Manager console with 
support for Mac devices. The Configuration Manager console is the primary interface to manage 
Mac computers in your enterprise. After you install Parallels Mac Management, the Mac-specific 
GUI elements are integrated into the console allowing you to accomplish Mac management tasks. 

Device Collections in Parallels Mac Management 
Configuration Manager collections help IT administrators to manage resources by combining them 
into logical groups based on a certain criteria. Parallels Mac Management adds the All Mac OS X 
Systems collection to organize Mac computers and the Unknown Mac OS X Systems collection 
that's used for OS X deployment. 

C H A P T E R  4  

Using Parallels Mac Management for 
Microsoft SCCM Features 
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To see the All Mac OS X Systems collection, open the Configuration Manager console and 
navigate to Assets and Compliance / Overview / Device Collections / All Mac OS X Systems. 
The collection can contain both managed and unmanaged Macs. A Mac is added to a collection as 
an unmanaged resource if Parallels Mac Client is not installed on it or if it's not registered with the 
Configuration Manager Proxy. You can still view the properties of an unmanaged Mac and connect 
to it using SSH or VNC if needed. 

To identify managed and unmanaged Mac resources in the All Mac OS X Systems collection: 

1 Right-click a resource and select Properties from the context menu.  

2 In the Properties dialog, select the General tab.  

3 In the Discovery data list, look up the "Client Version" property: 

• The client version of a managed resource will contain the Parallels Mac Client version 
number followed by "-PMA". For example: "5.1.6.804674-PMA".  

• The client version of an unmanaged resource will be "Unknown-PMA". 

The All Mac OS X Systems collection uses the following criteria in the WHERE clause of its SQL 
statement: 

ClientVersion LIKE '%-PMA' 

Therefore, the Mac resources that have the client version ending with "PMA" are displayed in the 
All Mac OS X Systems collection. You can create your own collections for Mac resources using a 
different criteria if needed. 

Unknown Mac OS X Systems is a special collection to which you deploy task sequences as part 
of OS X deployment. The collection is not supposed to contain any devices. For more information, 
see Operating System Deployment (p. 103). 

Hardware and Software Inventory 
The hardware and software information is collected from the enrolled Macs and is saved in the 
Configuration Manager database.  

To view the inventory data for a Mac computer: 

1 Open the collection containing Mac resources (e.g. All Mac OS X Systems). 

2 Right-click a Mac of interest and select Start > Resource Explorer in the context menu.  

3 The Resource Explorer snap-in opens where you can browse the inventory categories 
(classes) and view the relevant hardware and software information. 
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Reporting User Logon Information 

Mac user logon details are reported by the Parallels Mac Client to SCCM and are saved in 
hardware inventory. The logon information is reported using the standard nodes in the hardware 
inventory tree, which are described below. 

Computer System 

This node reports general computer information along with names of currently logged on users. The 
User Name column contains the user name in the qualifier\account format, where qualifier 
is the computer’s NetBIOS name or a domain name. If there's no currently logged on user, the 
column will contain SYSTEM as a value. 

 

Network Login Profile 

This node reports all existing local user accounts (even if they haven't logged on recently) and all 
domain users who have logged on in the last 90 days. Each row in the list represents the network 
login profile of a specific user: 

• The Name column contains the name of the account on a domain or the computer. 

• The Full Name column contains the full name of the user belonging to the network login profile. 

• The Home Directory column contains the path to the home directory of the user. 

• The Last Logoff and Last Logon columns indicate date and time the user last logged off the 
system and logged on to system respectively. 
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• The Number of Logons column indicates the number of successful times the user tried to log 
on to this account. 

 

System Console User 

This node allows you to easily see the top console user, which is the user who spends the most 
time logged on to the console. The information reported here is gathered from the OS X user 
accounting database by using logon and logoff events. When matching logon and logoff events are 
found, the information is used to calculate the amount of time the user was logged on. The 
resulting information is aggregated by user and ordered by total console usage. The information is 
calculated and displayed for the last 90 days. 

• The Last Console Use column contains the last date and time when the user logged off from 
the console. 

• The Number Of Console Logins column contains the total number of logons recorded in the 
user accounting database for the specific user. 

• The System Console User column contains the user name for the user logged on to the 
console. 
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• The Total User Console Minutes column contains the total number of console logon minutes 
recorded in the database for the user. 

 

Compliance Settings 
Compliance settings is a set of tools that allow you to assess the compliance of Mac computers in 
your organization with regard to whether OS X is configured correctly, volumes on Macs are 
encrypted, and whether Parallels Desktop (if installed) is configured properly. Compliance is 
evaluated by creating a configuration baseline that contains configuration items that you want to 
evaluate.  

This section contains information about how to create the configuration items, configure a 
configuration baseline, and then deploy the baseline to a device collection.  

Deploying OS X Configuration Profile 

Parallels Mac Management for Microsoft SCCM provides you with the functionality to monitor and 
enforce OS X configuration settings on Mac computers.  

First, you need to define a desired OS X configuration profile using of the following available 
methods: 

• Using a custom OS X profile editor. The editor is provided by Parallels Mac Management and is 
integrated in the Configuration Manager console. 

• Creating a profile from a .mobileconfig file that can be created using OS X Server Profile 
Manager. 

Creating OS X Configuration Profile Using Profile Editor 

To create an OS X configuration profile using the profile editor: 
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1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings / Configuration Items. 

2 Right-click Configuration Items, point to Create Parallels Configuration Item, and then click 
Mac OS X Configuration Profile. 

3 The Mac OS X Configuration Profile dialog opens. 
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The left pane of the dialog contains the list of payloads. The right pane contains the settings for a 
selected payload. When you select a payload for the first time, the right pane will only contain a 
short description and the Configure button.  
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2 Right-click Configuration Items, point to Create Parallels Configuration Item and click 
Parallels Desktop Configuration. The Parallels Desktop Configuration Profile dialog opens. 

 

3 Enter a name and and optional description for this configuration item. 

4 The Security page allows you to specify password requirements for using Parallels Desktop 
features and whether or not the Mac users will be allowed to change Parallels Desktop 
preferences. To enable password requirements, click the ON/OFF switch to toggle it to "ON" 
and then select the desired options. Do the same for the Edit Parallels Desktop settings 
option. 

• The License page allows you to specify the Parallels Desktop license key and customize the 
Request Support settings. The license key that you specify will be applied to Parallels Desktop 
on Mac computers (e.g. when you want to update it). The Request support settings allow you 
to specify the action for the Help > Request Support menu item in the Parallels Desktop 
graphical user interface. 

• The USB behavior page allows you to specify what to do when a USB device is connected to a 
Mac. 

• The Updates page allows you to specify Parallels Desktop update options. 

• The Network page specifies the Parallels Desktop network settings. 
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• The Miscellaneous page allows you to specify the default virtual machine folder and the 
participation in Parallels Customer Experience program. 

When finished, click OK to save the configuration item and close the dialog. To view the new item 
in the Configuration Items list, press F5 to refresh it. To modify the configuration item, right-click it 
and then click Edit Parallels Configuration Item in the context menu. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 88) for more 
information. 

Enforcing Parallels Desktop VM Settings 

A Parallels Desktop virtual machine has numerous configuration options that can be customized 
according to your organization requirements. To monitor Macs for virtual machine configuration 
compliance you need to create a virtual machine configuration item specifying the desired 
configuration parameters. 

Note: The settings that you specify in a virtual machine configuration item will be applied to all existing 
virtual machines on a Mac. 

To create a virtual machine configuration item: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 

2 Right-click Configuration Items, point to Create Parallels Configuration Item and click 
Parallels Virtual Machine Configuration.  
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3 The Virtual Machine Configuration Profile dialog opens. 

 

4 Enter a name and optional description for the configuration item. 

5 To specify the virtual machine configuration options to monitor, select an item in the left pane 
and specify individual configuration settings in the right pane.  

6 To include an option in the configuration profile and to specify its value click the ON/OFF switch 
to toggle it to "ON". To exclude an option, toggle the switch to "OFF". The excluded options will 
not be evaluated on managed Macs. 

7 When finished, click the OK button to close the dialog.  

To view the new configuration item in the Configuration Items list, press F5. To modify the 
configuration item, right-click it and then click Edit Parallels Configuration Item in the context 
menu. 
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To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 88) for more 
information. 

Using Scripts to Assess Compliance 

In addition to configuration profiles described in the previous sections, you can assess the 
configuration compliance of client Macs using scripts written in any language supported by OS X.  

To use scripts, you need to create a standard SCCM configuration item in the Configuration 
Manager console. When creating a configuration item, you have an option to specify a discovery 
script and a remediation script. The discovery script is used to obtain the value of a setting on a 
Mac to be assessed for compliance. The remediation script is used to remediate a non-compliant 
value if needed (creating a remediation script is optional).  

When a discovery script returns a value, it is assessed for compliance using the compliance rules 
defined for it. If the value is non-compliance and a remediation script exists, the value is passed to 
the script so that the necessary modifications can be done on the Mac. If a remediation script 
doesn't exist, the assessment stops and a noncompliance is reported to SCCM. Each discovery 
script can assess a single value, but multiple scripts with their own compliance rules can be added 
to a given configuration item. 

This section describes how to: 

• Create a configuration item using the Create Configuration Item Wizard (p. 84) 

• Create a discovery script (p. 86) 

• Create a remediation script (p. 86) 

• Specify the script interpreter to be used (p. 87) 

• Define Compliance Rules (p. 87) 

Creating a Configuration Item 

To use scripts to assess compliance, you need to create a standard SCCM configuration item.  

To create a configuration item: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings.  

2 Right-click Configuration Items and then click Create Configuration Item in the context 
menu.  

3 The Create Configuration Item Wizard opens.  

Follow the wizard to create a configuration item as described below. 
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General Page 

Specify the general properties of the configuration item: 

1 Specify the configuration item Name and an optional Description. 

2 Select Mac OS X in the Specify the type of configuration item that you want to create list 
box. 

3 Click Next. 

Supported Platforms Page 

Select the OS X versions to which this configuration item should be applicable. Please note that this 
selection will be ignored in the future releases of Parallels Mac Management. If at that time you'll 
need to exclude a particular OS X version, you can create multiple Mac collections based on the 
OS X version criteria and then selectively deploy the configuration item to them. 

Settings Page 

The Settings page is used to create a set of settings representing the conditions to assess for 
compliance on Mac computers. In our case, each setting will evaluate a particular value on a Mac. 

To create a new setting: 

1 Click New to open the Create Setting dialog. 

2 In the Create Setting dialog, specify the setting Name and an optional Description. 

3 In the Setting type list box, select Script. 

4 In the Data type list box, select the data type of the value that this setting will evaluate on a 
Mac. The discovery script that you'll specify later should return a value of the same data type in 
the string format. 

5 In the Discovery script section, click Add Script.  The Edit Discovery Script dialog opens 
where you can specify the discovery script. See Creating Discovery Script (p. 86) for the 
complete information. 

6 If you would like to create a remediation script, click Add Script in the Remediation script 
section. The Create Remediation Script dialog opens where you can specify the remediation 
script. See Creating Remediation Script (p. 86) for the complete information. 

7 Once you've specified the discovery and remediation scripts, you need to define compliance 
rules specifying the conditions that make the value returned by the discovery script compliant 
on Macs. To define compliance rules, make sure that you are back in the Create Setting dialog 
and click the Compliance Rules tab. To create a new rule, click New to open the Create Rule 
dialog. Use the dialog to define the rule. See Defining Compliance Rules (p. 87) for the 
complete information. You can create more than one rule for a given configuration item setting. 

8 When you are finished specifying scripts and compliance rules, click OK in the Create Setting 
dialog and then click Next on the Settings page of the wizard. 
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Compliance Rules Page 

The Compliance Rules page lists the compliance rules that you've created earlier. You can review 
and modify them if necessary. You can also create new rules here if needed. Click Next when 
ready. 

Summary, Progress, and Completion Pages 

Review the configuration item summary and click Next when ready. Wait for the configuration item 
to be created. Review the info on the Completion page and click Close to exit the wizard. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 88) for more 
information. 

Creating a Discovery Script 

A discovery script is specified using the Edit Discovery Script dialog, which is opened from the 
Create Setting dialog, which in turn is opened from the Create Configuration Item Wizard (p. 
84). 

The script can be written in any scripting language supported by OS X, such as Bash, Python, 
Apple Script, etc. See Specifying Script Interpreter (p. 87) for additional information. 

You can type (or copy and paste) the script into the Script edit box. If you have the script saved in 
a file, click the Open button to browse for it.  

A discovery script is used to find and return a value to be assessed for compliance on a Mac. The 
value can be of any data type supported by Configuration Manager, but must be returned by the 
discovery script as a string. Write the script to obtain the value of a desired setting on a Mac and 
return it as a string via standard output.  The returned value is evaluated using the compliance rules 
defined for this configuration item setting. If the value is non-compliance and a remediation script 
exists (p. 86), the value will be passed to the remediation script for evaluation. If the remediation 
script doesn't exist, the assessment stops and noncompliance is reported to SCCM. 

Please note that a discovery script will run in OS X with root privileges. Please also note that you 
cannot access OS X GUI components from a discovery script. For example, you cannot open a 
dialog to be displayed to the Mac user. 

Creating a Remediation Script 

A remediation script is created using the Create Remediation Script dialog, which is opened from 
the Create Setting dialog, which in turn is opened from the Create Configuration Item Wizard (p. 
84). 

The script can be written in any scripting language supported by OS X, such as Bash, Python, 
Apple Script, etc. See Specifying Script Interpreter (p. 87) for additional information. 
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You can type (or copy and paste) the script into the Script edit box. If you have the script saved in 
a file, click the Open button to browse for it.  

A remediation script is used to remediate non-compliance setting values found on a Mac. The non-
compliance value is passed to the script as an input parameter after obtaining it with the discovery 
script and assessing it using the compliance rules. A remediation script should return 0 (zero) as a 
string via standard output. 

When the remediation script returns, the discovery script is executed again to obtain the updated 
value. The value is then evaluated using the compliance rules. If the value complies, the 
assessment finishes with success. If the value is still non-compliance, a noncompliance is reported 
to SCCM. 

Please note that a remediation script will run in OS X with root privileges. Please also note that you 
cannot access OS X GUI components from a remediation script. For example, you cannot open a 
dialog to be displayed to the Mac user. 

Specifying a Script Interpreter 

When creating a discovery or a remediation script, use the syntax described below to specify the 
interpreter that should be used to run it. 

The first line of the script should begin with shebang and have the following format: 

#! interpreter [interpreter-args] <args-list-terminator> [#comment] 

where: 

• interpreter is the absolute path to the interpreter executable (e.g. /bin/bash). 

• interpreter-args is the list of the interpreter arguments. 

• args-list-terminator is the terminating character of the argument list. The terminator is needed 
for passing the result of the discovery script to the remediation script. 

Python example: 

#! /usr/bin/python - 

Bash example: 

#! /bin/bash -- 

• comment is a comment that you might want to add to the script. 
 

Creating Compliance Rules 

A compliance rule defines compliance conditions for the value returned by the discovery script. The 
conditions are defined using the Create Rule dialog, which is opened from the Create Setting 
dialog, which in turn is opened from the Create Configuration Item Wizard (p. 84). 
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To create a rule, do the following in the Create Rule dialog: 

1 Specify the rule Name and an optional Description. 

2 Set the Rule type to Value. 

3 Use the The setting must comply with the following rule section to specify the rule. 

4 If you specified a remediation script for this configuration item setting, you may select the Run 
the specified remediation script when this setting is non-compliance option. If this option 
is selected and the value is non-compliance, the remediation script will be executed and the 
value will be passed to it as a parameter. 

5 The Report noncompliance if this setting instance is not found option affects the 
compliance or non-compliance reporting. When the script execution doesn't fail, but doesn't 
return any data either, the rule is not evaluated. Instead, the compliance status is determined by 
the state of this option as follows: 

• If the option is selected, compliance is reported. 

• If the option is cleared, non-compliance is reported. 

6 Click OK to create the rule and close the dialog. 

You can create more than one rule for a given configuration item setting. If there's more than one 
rule, they will be connected using the logical AND operator. Therefore, for a value to be compliant, 
all rules must evaluate as TRUE. 

Deploying Configuration Baseline 

Once you've created one or more configuration items, you need to add them to a configuration 
baseline. Configuration baseline is a container that combines configuration items into a logical unit 
so they can be evaluated for compliance by Macs as a group. You can add configuration items to 
an existing baseline or you can create a new one. 

To create a configuration baseline: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 

2 Right-click Configuration Baselines and then click Create Configuration Baseline in the 
context menu. The Create Configuration Baseline dialog opens. 

3 Enter the desired configuration baseline name and description. 

4 Click the Add button and then select the configuration items that you want to add to the 
baseline. Click OK and click OK again. 

The new configuration baseline will appear in the Configuration Baselines list. You can click 
Refresh on the toolbar to refresh the list. 

Once a configuration baseline is created, you need to deploy it to a Mac collection. 

To deploy a configuration baseline: 
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1 In the Configuration Manager console, right-click the baseline that you've created and click 
Deploy in the context menu.  

2 In the Deploy Configuration Baselines dialog, click the Browse button.  

3 In the Select Collection dialog, select Device Collections in the drop-down list box and then 
select the All Mac OS X Systems collection in the list. Click OK. 

4 When back in the Deploy Configuration Baselines dialog, specify the desired schedule for the 
baseline and click OK. 

A configuration baseline will run as scheduled for as long as it exists. To delete a baseline, right-
click it and then click Delete. 

Receiving Compliance Settings Reports 

Corporate policies can be enforced on Mac computers using the Compliance Settings functionality. 
Parallels Mac Management for Microsoft SCCM provides a reporting functionality that allows you to 
evaluate the results of enforcing corporate policies on individual Mac computers. 

To enforce a policy, the IT administrator creates a configuration item, adds it to a baseline, and 
then deploys the baseline to a Mac collection. When the baseline runs, each configuration item is 
applied to a Mac and modifies a corresponding configuration according to the rules that it contains. 

After the configuration changes are made to the Mac, the following reports are generated on the 
Mac side: 

• A report for each configuration item applied to a Mac (a configuration baseline can contain 
more than one configuration item, so a report is generated for each individual item).  

• A summary report for the baseline after all configuration items are applied to a Mac.  

As soon as a report is generated, the Parallels Mac Client sends it to the Configuration Manager 
Proxy, which sends it to the Configuration Manager. When the Mac evaluation for compliance 
completes, the IT administrator can view the reports in the Configuration Manager console. If the 
Parallels Mac Client cannot establish a connection with the Configuration Manager Proxy, the 
reports are saved locally on the Mac and the transfer is resumed as soon as the connection 
becomes available. 

To view the evaluation reports in the Configuration Manager console, you need a reporting point set 
up on your Configuration Manager site. If you don't have a reporting point, set it up in the 
Configuration Manager console using the standard Configuration Manager functionality. 

To view the Compliance Settings reports: 

1 In the Configuration Manager console, navigate to Site Database / Computer Management / 
Reporting / Reports.  

2 In the report list, find the "Compliance for a computer by configuration item" report or the 
"Compliance for a computer by configuration baseline" report, right-click it and then click Run 
in the context menu. 
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3 Specify the report criteria using the provided options (computer name, configuration item 
name). 

4 Click Display to view the report. 

A compliance report contains the basic information about the Mac computer and the configuration 
item (or configuration baseline) together with the following items describing the results of the Mac 
compliance evaluation: 

• Compliance State — describes whether the Mac complies with the corporate policies defined 
in the configuration item(s). The possible values are Compliant and Non-compliant. 

• Last Evaluation Date and Time (UTC) — contains the last evaluation date and time. 

Software Distribution 
The software distribution feature automates the distribution of software to managed Mac 
computers. Software is distributed to Macs using the standard Configuration Manager functionality.  

Creating a Software Package 

A software package is a container for an application, file, or information that need to be applied to 
client Mac computers. A package also includes a program that contains instructions for how the 
contents of the package is to be applied on a Mac.  

You create a package and a program using the standard Create Package and Program Wizard 
in the Configuration Manager console. Once the package is created, you can set additional 
package and program properties that are not available in the wizard. These properties can be used 
to better manage the package installation on a Mac computer.  

To create a software package: 

1 In the Configuration Manager console, navigate to Software Library / Overview / Application 
Management / Packages.  

2 Click Create Package. The Create Package and Program Wizard opens.  

Complete the Create Package and Program Wizard as described below. 

The Package Page 

Specify the general package information: 

1 Specify the package name and an optional description, manufacturer, language, and version 
information.  

2 Select the This package contains source files option and then click Browse to select the 
folder containing the software installation image. 
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3 Click Next. 

The Program Type Page 

Select the Standard program option and click Next.  

The Standard Program Page 

1 Specify the program name.  

2 Specify the command line for the program using the following rules: 

• A command line that doesn't start with the colon (:) is treated as a standard OS X shell 
command and is executed as-is. For example, to run the OS X installer(8) to install a .pkg 
package, the command line will look like this: 

installer -pkg "InstallMe.pkg" -target / 

• To copy a directory from the distribution package to the Mac hard drive, use the following 
syntax: 

:<source_path>:<destination_path>: 

where <source_path> is the name and path of a directory inside the package, and 
<destination_path> is the name and path of a directory on a Mac. To reference directories 
inside an image file, the source path may contain the image file name (the file with the 
".dmg" or ".iso" extension). For example, command line  

:firefox-8.0.1.dmg/Firefox.app:/Applications: 

will mount the firefox-8.0.1.dmg image to a temporary mount point and then copy the 
Firefox.app folder from that mount point to the /Applications folder on the Mac. The 
following example will do the same with the .iso image file 

:MySoft-image.iso/MyApp.app:/Applications: 

• To run an installer command (OS X package installer tool), use the following syntax: 

:<package_path>:: 

where <package_path> is the name and path of the package. When the client encounters 
this command, it will invoke installer(8) passing the package name to it as a parameter. For 
example, command line 

:MySoft/MySoft-1.0.dmg/packages/mysoft_v1.pkg:: 

will mount the MySoft-1.0.dmg image to a temporary mount point, make it current directory, 
and execute the following command: 

$ /usr/sbin/installer -pkg "packages/mysoft_v1.pkg" -target / 

The following example will similarly mount an .iso image file: 

:MySoft/MySoft-1.0.iso/packages/mysoft_v1.pkg:: 

3 Specify whether you want to allow Mac users to interact with the program installation.  
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• To enable user interaction, in the Run mode drop-down list, select Run with user's rights 
or select the combination of the Run with administrative rights and Allow users to view 
and interact with the program installation options. 

• To disable user interaction, set the Run mode option to Run with administrative rights 
and clear the Allow users to view and interact with the program installation option. 

If you allow user interaction, a dialog will be displayed in OS X during program installation giving 
the user a choice to continue or to postpone installing the program. The message in the dialog 
will say whether an additional action, such as computer restart or user log-off, will be required 
(or may be required) after the program installation finishes. Based on this info, the user can 
decide whether to continue or to postpone the program installation. Please note that if a 
program installation is postponed, no other program can be installed before this one is installed 
first. 

4 Click Next. 

The Requirements Page 

Specify the following optional properties: 

• Estimated disk space. Specifies the required disk space required to install the software on a 
target Mac. If a Mac doesn't have enough disk space, the software will not be installed on it 
and the Parallels Mac Client will report an error to the Configuration Manager. 

• Maximum allowed run time (minutes). Limits the maximum run time of the installation 
process. If the specified value is exceeded, the installation process is terminated and the failure 
is reported to the Configuration Manager. 

Click Next and complete the wizard 

Once the package is created, you can set additional package and program options that are not 
available in the wizard. The following subsections describe these options. 

Specifying Actions to Perform After the Package Installation Finishes 

You can configure the package program to restart a Mac or log off the user after the package 
installation finishes. Use these options when the software that you are distributing to Macs requires 
such actions to complete the installation.  

To configure the program: 

1 In the Configuration Manager console, select the package that you created and click the 
Programs tab at the bottom of the Packages workspace.  

2 Select the program and click Properties on the toolbar. The program Properties dialog opens.  

3 On the General tab, in the After running list, select the action that should be performed after 
the package installation finishes: 

• No action required. This is the default option. If selected, no additional action will be 
performed on a Mac after the package installation finishes. 
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• Configuration Manager restarts computer. When this option is selected, a dialog box will 
be displayed in OS X notifying the user that the Mac must be restarted. The user can 
postpone restarting if needed. If the action is postponed, the user will be reminded to restart 
the Mac later. If there are other packages waiting to be installed on the Mac, they will be 
installed only after the Mac is restarted. 

• Program controls restart. Same as No action required. 

• Configuration Manager logs user off. A dialog box will be displayed notifying the user that 
they have to log off to complete the installation. The user can postpone it if needed. If the 
action is postponed, the user will be reminded to log off later. The Parallels Mac Client will 
report success to the Configuration Manager even if the user postpones logging off the Mac 
as long as the installation completes without errors. The Parallels Mac Client will send the 
detailed installation results to the Configuration Manager as soon as the user logs off and 
then logs on again. If there are other packages waiting to be installed on the Mac, the 
installation will begin only after the user logs off and then logs on again. 

See also Create Package and Program Wizard 

Sending a Package to a Distribution Point 

To distribute a package to client Macs, a copy of the package data must be sent to a distribution 
point from which the clients can download it. 

To send a copy of the package to a distribution point, right-click the package of interest and click 
Distribute Content in the context menu. Use the Distribute Content Wizard to specify a 
distribution point to which you want to send the package.  

Please make sure that the distribution point is properly configured as described in the Configuring 
a Distribution Point section. 

Deploying Software 

After you've sent the package to a distribution point, you can deploy the software. 

To deploy the software: 

1 In the Configuration Manager console, right-click the package and then click Deploy in the 
context menu. The Deploy Software Wizard opens.  

2 On the General page, click the Browse button next to the Collection field and select the 
collection containing the desired Mac resources (e.g. All Mac OS X Systems). Click OK and 
then click Next. 

3 On the Content page, verify the distribution point info and click Next. 

4 Click Next on the Deployment Settings page. 

5 On the Scheduling page, specify the schedule for this deployment. Click New to specify the 
assignment schedule. When done, click Next. 
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6 Use the default values on the rest of the wizard pages and complete the wizard. 

The software will be advertised to Macs in the specified collection and will be distributed to them 
according to the schedule that you specified. 

Viewing the Package Status 

While software distribution is in progress, the Parallels Mac Client running on target Mac computers 
will report to the Configuration Manager the following events: 

• Download started — the event is reported when the client on a Mac begins downloading the 
software. 

• Download finished — the event is reported when the package download is complete. 

• Download failed — the event is reported if the package download fails. 

To view the status of a package: 

1 In the Configuration Manager console, navigate to Monitoring / Overview / System Status / 
Deployments. 

2 In the right pane, right-click the package and then click View Status in the context menu. 

3 Use the Deployment Status view to examine the deployment status. 

Application Management 
Application management in SCCM provides the tools to manage applications in the enterprise. 
Applications are similar to distribution packages, but contain more information to support smart 
deployment. Parallels Mac Management natively supports the application management feature of 
SCCM and allows you to deploy applications on Mac computers. 

The steps to create and deploy a Mac application are: 

1 Choose the installation type (install an application on a Mac silently or interactively) (p. 95) 

2 Prepare a Mac application for Configuration Manager (p. 95) 

3 Create a Configuration Manager application (p. 95) 

4 Configure the Deployment Type (p. 98) 

5 Deploy the application (p. 99) 

The remaining topics in this section describe how the application is installed on a Mac and how to 
use the Parallels Application Portal. 

• Installing Application on a Mac (p. 101) 

• Using Parallels Application Portal (p. 102) 
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Choose the Installation Type 

When preparing a Mac application for deployment, you can configure it to be installed on a Mac 
silently (transparently to a Mac user) or you can allow the user to interact with the installation 
process. 

Silent Installation 

If you configure the application to install silently, it will be delivered to a Mac and installed without 
giving the user any control over the installation process. The only operation that the user will be 
asked to confirm is restarting the Mac if it is required by a particular application. The options that 
must be set in order to perform a silent installation are highlighted in the corresponding topics 
describing the application deployment steps. 

Interactive Installation 

An interactive installation informs the Mac user that the application is available for installation and, 
depending on the deployment configuration, gives the user full or limited control over the installation 
process. 

When preparing an application for interactive installation, you can specify the following options: 

• An application can be either required to be installed or the user can be given a choice whether 
to install it or not. 

• The application installer can be displayed on the screen allowing the user to control the 
installation process, or the installer can run in the background thus performing an unattended 
installation. In both scenarios the user can choose whether to run the installer as soon as the 
application is available or to postpone it to a later time. 

The options that must be set in order to perform an interactive installation are highlighted in the 
corresponding topics describing the application deployment steps. 

Parallels Application Portal 

When an application is configured to be deployed interactively as described above, it will be added 
to the Parallels Application Portal on a Mac, which is an OS X application that allows a Mac user to 
view and install applications made available to them by their system administrator. Parallels 
Application Portal is described in detail in the Using Parallels Application Portal section (p. 102). 

Prepare a Mac Application for Configuration Manager 

Before you can deploy a native OS X software package (.app, .dmg etc.) in SCCM, you must use 
the CMAppUtil tool to convert it to the .cmmac format that Configuration Manager understands. 

The CMAppUtil tool is provided by Microsoft: 
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1 Download the ConfigmgrMacClient.msi file from the Microsoft Download Center. Use one of 
the following URLs depending on the SCCM version you are using: 

• SCCM 2012 R2: www.microsoft.com/en-us/download/details.aspx?id=39360 

• SCCM 2012: www.microsoft.com/en-us/download/details.aspx?id=36212 

2 Run the downloaded file on your Windows computer to extract the macclient.dmg file. The file 
is extracted by default to the following folders: 

• SCCM 2012 R2: C:\Program Files (x86)\Microsoft\ System Center 2012 R2 Configuration 
Manager Mac Client 

• SCCM 2012: C:\Program Files\Microsoft (x86)\System Center 2012 Configuration Manager 
Mac Client  

3 Copy the macclient.dmg file to a Mac computer. 

4 Double-click the file to see its contents. Extract the Tools folder from the file by dragging and 
dropping it to a folder on your Mac. 

CMAppUtil supports the .dmg, .pkg, .mpkg, .app file formats. 

To convert an OS X application package to the .cmmac format: 

1 Copy the OS X package to the folder where you extracted to Tools folder. 

2 Navigate to the Tools folder and enter the following command-line: 

./CMAppUtil <properties> 

For example, to convert an Apple disk image file named MySoftware.dmg stored in the user's 
home folder to the .cmmac format: 

./CMApputil –c /Users/ <User Name> /MySoftware.dmg -o /Users/ <User Name> 

The command above creates a .cmmac installation file compatible with Configuration Manager. 
The -c option specifies the source file being converted. The -o option specifies the output path. 
For the complete list of options, please consult the Microsoft CMAppUtil documentation. 

When you have the .cmmac file, copy it to a network share where it can be accessed from the 
Configuration Manager console. 

Create a Configuration Manager Application 

To create a Configuration Manager application using the Create Application Wizard: 

1 In the Configuration Manager Console, navigate to Software Library / Application 
Management.  

2 Right-click Applications and click Create Application. This will open the Create Application 
Wizard. 

3 On the General page, select Mac OS X in the Type drop-down list.  
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4 Click Browse, enter the network location of the .cmmac file that you've prepared earlier, select 
the file and click Open. 

5 Click Next. Review the information on the Import Information page and click Next. 

6 On the General Information page, specify the application name, and optionally publisher, and 
version. Click Next. 

7 Review the application settings on the Summary page and click Next.  

8 Wait until the application is created and then click Close to close the wizard. 

The new application will appear in the Applications list in the Configuration Manager console.  

Specify Application Properties for Parallels Application Portal 

The application properties described here determine how the application will be displayed in the 
Parallels Application Portal on a Mac. If you would like to configure the application to be installed 
silently (you will choose the installation type later), you may skip this sub-section. 

To set up the application properties for the Parallels Application Portal: 

1 Right-click the application that you've created in the previous step and click Properties in the 
context menu. This will open the application properties dialog. 

2 Click the Application Catalog tab and set the following properties: 

• Selected language  — select the language from the drop-down list. Click Add/Remove to 
add additional languages if needed. 

• Localized application name — specify the localized application name. 

• User categories  — click Edit to specify user categories that the users of Parallels 
Application Portal can use to filter and sort the available applications. The Edit button opens 
the User Categories dialog. Select an existing category or click Create to create a new 
category. 

• Icon  — click Browse to select an icon for this application. 

• Display this as a featured app and highlight it in the company portal  — if you select 
this option, the application will be listed in the Featured Applications list in Parallels 
Application Portal. 

3 If the application that you are creating is an upgrade or a replacement for an existing application 
in the Parallels Application Portal, then you can specify a supersedence relationship on the 
Supersedence tab page. Select the Allow users to see deployments for this an all 
applications that it supersedes... option if you want to display all versions of the application in 
the Application Portal. If the option is cleared, only the top application will be shown. 

4 Click OK to close the Properties dialog. 
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Configure the Deployment Type 

The deployment type for the application is created automatically when you create the Configuration 
Manager application. This section describes some of the deployment type properties that you may 
want to modify. 

To modify the properties of the deployment type: 

1 Select the Deployment Types tab at the bottom of the Applications workspace.  

2 Right-click the deployment type and click Properties in the context menu.  

3 The <application_name> - Mac OS X Properties dialog opens. 

Use the following instructions to modify the deployment type properties as needed. 

Specify the Installation Command Line 

To specify the command that you want to use to install, and optionally uninstall, the application on 
a Mac, click the Programs tab. The Installation program field is used to specify the command 
line. The field is populated automatically and should already contain the installation command for 
the application. You can modify the command line as needed. 

If you've configured the application for the Parallels Application Portal, you can optionally specify an 
uninstallation command for it. This will enable the Remove button in the Application Portal and will 
provide a convenient method for removing an application from a Mac. To add the uninstallation 
command line, use the following syntax: 

:<Installation command>:<Uninstallation command>: 

The <Installation command> and <Uninstallation command> parts should contain the installation 
and uninstallation commands respectively. You have to find out what the actual uninstallation 
command line for a given application is yourself.  

As an example, the following command line contains the installation and uninstallation commands 
for Firefox (please note the colon characters, which are required): 

:/usr/bin/ditto "Firefox.app" "/Applications/Firefox.app":rm -rf "/Applications/Firefox.app": 

When you add the uninstallation command to the command line, the Remove button in the 
Parallels Application Portal becomes available once the application is installed on a Mac. If you 
don't include an uninstallation command, the Remove button will be disabled for the given 
application. 

Specify the Mandatory Mac Restart Option 

To force a mandatory Mac restart after the application is installed on it, click the User Experience 
tab. In the Action drop-down list, select the action from the following options: 
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• No action — The Mac will be restarted only if the application installer requires it. 

• Configuration Manager client will force a mandatory device restart — The Mac will be 
restarted regardless of whether the application installer requires it or not. 

Specify Detection Method 

The Detection Method tab page allows you to specify how Configuration Manager determines 
whether this deployment type is already present on a Mac. This information is automatically 
imported when you convert the OS X installation image to a .cmmac file.You can modify the 
imported information, if needed, by editing the existing clause or creating a new one. 

To modify or create a clause: 

1 On the Detection Method tab page, select the existing clause and click Edit Clause (or click 
Add Clause). 

2 Select the Setting Type. The available options are Application Bundle and Package ID: 

• For Application Bundle, specify Application bundle ID, Data Type (String or Version), 
Operator, and Value. 

• For Package ID, specify Package ID, Operator, and Value. 

3 Click OK to save the changes and close the dialog. 

Specify System Requirements 

The Requirements tab page allows you to specify system requirements that must be met to allow 
the application to be installed. The only requirement that can be currently specified is the OS X 
version. 

To specify the OS X version requirement: 

1 On the Requirements tab page, click the Add button. 

2 In the Category drop-down list, select Device. 

3 In the Condition list, select Operating system. 

4 In the OS X tree, select one or more OS X versions. If you check Select all, all existing and all 
future OS X versions will satisfy the requirement. 

5 Click OK to save the changes and close the dialog. 

Deploy the Application 

After you've created the Configuration Manager application and configured the deployment type, 
you need to deploy the application to a Mac collection. 

To deploy the application: 
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1 Right-click the application and click Deploy in the context menu. This will open the Deploy 
Software Wizard. 

2 On the General page, click Browse to select the target Mac collection.  

3 In the Select Collection dialog, select Device Collection in the drop-down list, and then select 
the target collection (e.g. All Mac OS X Systems). Click OK. 

4 Click Next. 

5 On the Content page, click Add to add a distribution point that will host this content. Select a 
distribution point and click OK. 

6 Click Next. 

7 On the Deployment Settings page, in the Action drop-down list, select Install.  

8 In the Purpose list, select Available or Required: 

• If you select Available, the application will appear in the Parallels Application Portal on a 
Mac as available for installation, but the user will not be required to install it. 

• If you select Required, the user will be required to install the application. If you want the 
application to be installed silently, you must select this option and also select the Hide in 
Software Center and all notifications option described in step 12 below. 

9 Click Next. 

10 On the Scheduling page, specify the schedule at which this application should be available to 
Mac users. 

If you've selected the application Purpose as Required on the previous page (step 8 above), 
you'll need to specify the Installation deadline for the application. The following deadline 
options are available: 

• As soon as possible — Mac users will be required to install the application as soon as it is 
available. If a user fails to install the application right away, he/she will be reminded again in 
24 hours. If the application is still not installed after that, it will be installed automatically.  

• Schedule at — Mac users will be required to install the application before the date and time 
specified here. If a user fails to install the application, it will be installed automatically. 

11 Click Next. 

12 On the User Experience page, select a notification type in the User notification drop-down 
list. Depending on the option selected, the following will happen when the application is ready 
to be installed on a Mac: 

• Display in Software Center and show all notifications — The user will be asked to install 
the application and will have an option to start or postpone the installation. If the application 
is configured as Available (i.e. not required, see step 8 above) the user will have a choice 
not to install it. The application will be added to the Parallels Application Portal where the 
user will be able to install it later. The installer graphical user interface will be displayed to the 
user providing full control over the installation process. When the installation is finished, the 
user will be asked to reboot the Mac if necessary. 
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• Display in Software Center and only show notifications for computer restarts — This 
option is similar to the Display in Software Center and show all notifications option 
(above) with one exception: the installer will run in the background, so the user will have no 
control over the installation process. The user will still be given a choice to install the 
application or to postpone the installation, and to restart or postpone restarting the Mac if it 
is required. 

• Hide in Software Center and all notifications — The user will NOT be informed that the 
application is available for installation. The installation will be performed completely silently 
and transparently to the user. The application will NOT be added to the Parallels Application 
Portal. If the installation requires Mac restart, the user will be asked to restart it and will be 
given an option to postpone restarting. 

13 Complete the wizard using the default values and close it when done. 

Read on to learn how the application can be installed on a Mac after it's been deployed. 

Installing the Application on a Mac 

When the application becomes available for installation on a Mac, the following will happen 
depending on the installation type deployment configuration options. 

Installation is Optional 

If the application is not required (the Deploy Software Wizard | Deployment Settings | Purpose 
is specified as Available), a dialog will be displayed to the user describing the application and 
providing the following choices: 

• Show in Application Portal — Clicking this button will open the Parallels Application Portal 
where the user can view the application and install it if desired. 

• Install now — Clicking this button will download the application and will run the application 
installer. The installer GUI will be displayed or hidden depending on the setting specified on the 
User Experience page of the Deploy Software Wizard. 

• Close — Clicking this button will close the dialog. The user will be able to install the application 
later from the Application Portal. 

Installation is Required 

If the application is required (the Deploy Software Wizard | Deployment Settings | Purpose is 
specified as Required) and an interactive installation type was specified, a dialog will be displayed 
to the user with the following options: 

Postpone — This button allows the user to postpone the installation. The Remind me in drop-
down list allows the user to select the postponement period. 

Depending on the installation deadline setting (set in the Deploy Software Wizard | Scheduling 
page), the following rules apply: 
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• If the policy was downloaded prior to the installation deadline, the deadline will stay in effect. 

• If the policy was downloaded after the deadline has passed, the effective deadline will be set to 
the time of the policy download plus 24 hours. 

Install now — Clicking this button will close the dialog and will run the application installer. 

Installation is Silent 

If the installation type was specified as silent (the Deploy Software Wizard | User Experience 
page | Hide in Software Center and all notifications option was selected), no message asking 
the user to install the application will be displayed, and the installation will be performed silently as 
soon as the policy is delivered to a Mac. 

In all three scenarios above, after the application is installed, the user will be asked to reboot the 
Mac if the installer requires it or if the Action on the User Experience page of the Mac OS X 
Properties dialog is set to force a mandatory restart. 

Using Parallels Application Portal 

Parallels Application Portal is an OS X application included in the Parallels Mac Management for 
Microsoft SCCM package. The application is installed on a Mac when Parallels Mac Client is 
installed on it.  

To start Parallels Application Portal on a Mac, navigate to Finder > Applications and double-click 
Parallels Application Portal. 

 

Parallels Application Portal allows the Mac user to: 

• View and install applications made available to them by their system administrator. 

• View and remove installed applications. 
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• Filter the applications by category and publisher. 

For an application to be listed properly in the Parallels Application Portal, it must be configured and 
deployed as described in Application Management and its subsections (p. 94). 

When Parallels Application Portal starts, it should contain the list of installed and available 
applications. If a Mac is not assigned to a Configuration Manager site, the application list will be 
empty. 

The Parallels Application Portal window has the following elements: 

• All Applications tab — Lists all application, including installed applications and applications 
that are available for installation. If at least one application was configured as "featured", the list 
will be split into two parts: Featured Applications and Other Applications. An application can 
be configured as "featured" on the Application Catalog tab page of the <application_name> 
Properties dialog (p. 96). If Configuration Manager has multiple versions of the same 
application that supersede each other, only the top application will be displayed unless the 
system administrator has specified the supersedence relationship on the Supersedence tab 
page of the <application_name> Properties dialog in the Configuration Manager console. 

• Installed Applications tab — Lists applications that are installed on this Mac. 

• Categories list — Contains software categories that the user can select to filter the application 
lists. 

• Publishers list — Contains the names of software vendors that the user can select to filter the 
application lists. 

• Install button — Displayed for applications that are available for installation. Clicking this button 
will download an application to the Mac and install it. 

• Remove button — Displayed for an application already installed on a Mac. Allows the user to 
remove the application from the Mac. Please note that this button will only be available for 
applications that were configured in Configuration Manager as "Available" (i.e. optional, as 
opposed to required) and for which the uninstallation command line was specified. For more 
info about the installation/uninstallation command line, see Configuring the Deployment Type 
> Specify the Installation Command Line (p. 98). 

Operating System Deployment 
Parallels Mac Management provides you with the ability to deploy OS X on Mac computers. To 
deploy OS X on Macs, you must take the following actions: 

1 Capture an OS X boot image by using the image builder utility included with Parallels Mac 
Management. 

2 Capture an OS X system image using a task sequence or the image builder utility. 

3 Distribute the boot image and the system image to a distribution point. 

4 Create a task sequence that will deploy the OS X system image and optionally execute other 
steps, including: 
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Troubleshooting 

The following log becomes available when a Mac boots from the network: 

• /Library/Logs/pmm_tswizard.log 

You can view the log file in Terminal which can be opened from the Utilities menu. Please note 
that after the OS X image is deployed and the Mac is rebooted, the log file will be moved to the 
deployed OS partition. 

The following logs become available when the Mac is rebooted after the OS X image deployment 
step: 

• /Library/Logs/pmm_launchd_helper.log 

• /Library/Logs/pmm_ts_executor.log 

The logs are finalized when the task sequence execution completes. You can view them when 
you log into the Mac. To view these logs while the task sequence is executing, connect to the 
Mac via SSH and view the logs in the SSH terminal. 

Apple Software Update Management 
Parallels Mac Management for Microsoft SCCM allows you to manage Apple software updates 
(patches) for OS X using the native SCCM functionality, just like you manage Windows updates 
from Microsoft. Using this functionality you can import Apple software updates into SCCM and then 
deploy them to Macs in your organization. 

To use the Apple Software Update Management functionality, you must install the OS X Software 
Update Point component when installing Parallels Mac Management. If you haven't installed the 
component, please run the Parallels Mac Management installer again and install it. 

Configuring Software Update Options 

This sections describes Parallels OS X Software Update Point options that you can configure. Read 
this section to determine whether the default options work for you. If they don't, you can configure 
them according to your needs. 

Choosing an Update Server Type 

Macs normally download and install OS X updates from the Apple Software Update server. This is 
the default behavior of the Parallels OS X Software Update service as well. However, you can use a 
suitable local software update service (provided by Apple or some other vendor) to host OS X 
updates locally. 

The following describes the available options of setting up a software update server. 
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4 In the message viewer, you will see the "WSUS Synchronization done" record. 

 

Configure the Software Update Point Role 

You now need to configure the software update point role to synchronize Apple software updates. 
To do so, follow these steps: 

1 Navigate to Administration / Overview / Site Configuration / Sites.  
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2 Right-click your site and choose Configure Site Component > Software Update Point. 
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3 On the Classifications tab page, select the Updates option. 

 

4 On the Products tab page, select Apple and click OK.  
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Note: If the Apple product is not present on the Products tab page it's because the software update 
point did not synchronize with WSUS after the Apple software updates were imported. In such a case 
try repeating the steps described in this topic from the beginning. 

 

Synchronizing SCCM with WSUS 

Once the synchronization of SCCM with WSUS is configured, you need to perform the actual 
synchronization. You can either schedule the synchronization or you can perform it manually. The 
manual synchronization procedure is described below. If you want to run it on a schedule, please 
refer to the SCCM documentation. 
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To synchronize SCCM with WSUS manually: 

1 Run the WSUS synchronization again. 
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2 You will get all of the available Apple software updates in the Software Library / Overview / 
Software Updates / All Software Updates. 

 

Deploying Updates to Macs 

When Apple updates are displayed in the All Software Updates list, you can work with OS X 
updates just like you work with Windows updates using the standard Configuration Manager 
functionality.  

To deploy the updates, create a Software Update Group and then deploy it to a collection of Macs. 
The Macs will process policies according to the policy polling interval. When policies with software 
update assignments arrive, the Parallels Mac Client will evaluate assignments and install assigned 
updates if necessary. If an update requires a restart, the Mac user will be asked to either restart 
now or to postpone it. A restart will not be initiated without user's approval, even if the deadline for 
an assignment is reached. 

Limitations and Known Issues 

The Software Update Management functionality has the following limitations: 

• Updates with the "Not Required" status are not reported as OS X updates. 

• Updates imported into WSUS will not be updated again if the update information is changed in 
the catalog downloaded from Apple. 
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Deploying Parallels Desktop to Macs 
Parallels Desktop for Mac is a virtualization software that allows you to run Windows and other 
operating systems on a Mac computer alongside OS X. Parallels Mac Management for Microsoft 
SCCM enables you to deploy Parallels Desktop to Mac computers. Deploying Parallels Desktop to 
Macs is similar to distributing other software: you create a distribution package, add a program to 
it, copy the package to a distribution point, and create an advertisement (see Software 
Distribution (p. 90)). Parallels Desktop deployment adds a few extra steps, which are described 
below. 

Preparing a Deployment Package 

Parallels provides a special software package that can be used to mass deploy Parallels Desktop to 
many Macs at once. 

To prepare the deployment package: 

1 Download the package to your Windows server where the Configuration Manager console is 
running using the following URL: 

http://download.parallels.com/desktop/tools/pd-autodeploy.zip 

2 Unzip the file. You should see the Parallels Desktop Business mass deployment 
package vx.x.x folder (where x.x.x is the package version number). 

3 Open the folder and navigate to Parallels Desktop Autodeploy.pkg\Parallels 
folder, which should contain the deploy.cfg file.  

4 Open the file in WordPad (or other advanced text editor), find the License section and type 
your Parallels Desktop license number as a value of the license_key variable. Save the file. 

5 Copy the Parallels Desktop installation disk image (.dmg file) to the Parallels Desktop 
Autodeploy.pkg\Parallels folder where the deploy.cfg file is residing. 

Adding Virtual Machines to the Deployment Package 

If you would like to distribute one or more virtual machines together with Parallels Desktop, you 
have to add them to the deployment package. To include a virtual machine, locate the virtual 
machine bundle (the file with the .pvm extension) and copy it to the Parallels Desktop 
Autodeploy.pkg\Parallels folder.  

Parallels Desktop and a source virtual machine can be configured before deployment in a number 
of ways according to your requirements. This includes the general virtual machine configuration 
parameters, such as the number of CPUs, available RAM, hard disk size, etc., as well as additional 
configuration options. For the complete information on how to customize Parallels Desktop and 
virtual machines before the deployment, please read the Parallels Desktop Business Edition for 
IT Administrators guide. 
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Creating a Software Distribution Package 

The Parallels Desktop deployment package is distributed to Macs using the standard Configuration 
Manager functionality: 

1 In the Configuration Manager console, navigate to Software Library / Overview / Application 
Management / Packages. 

2 On the toolbar, click Create Package. Use the Create Package and Program Wizard to 
create a software distribution package and program.  

3 On the Package page, specify the package name and an optional description, manufacturer, 
language, and version information. Select the This package contains source files option and 
click Browse. Select the folder that contains the Parallels Desktop Autodeploy.pkg 
folder. Please note that you must select the parent folder of the Parallels Desktop 
Autodeploy.pkg folder, NOT the .pkg folder itself. 

4 Click Next. 

5 On the Program Type page, select the Standard program item and click Next. 

6 On the Standard Program page, specify the information about the program. You can create a 
package that will require user interaction or a package that will install automatically.  

• To create a package requiring user interaction, type the following in the Command line 
field: 

chmod 700 "Parallels Desktop 
Autodeploy.pkg/Contents/Resources/postflight" && 
/System/Library/CoreServices/Installer.app/Contents/MacOS/Installe
r "Parallels Desktop Autodeploy.pkg" 

Specify the Run mode as Run with administrative rights and select the Allow user to 
view and interact with the program installation option. 

• To create a package that will install automatically, the command line should be: 

chmod 700 "Parallels Desktop 
Autodeploy.pkg/Contents/Resources/postflight" && installer -pkg 
"Parallels Desktop Autodeploy.pkg" -target / 

DO NOT select the Allow user to view and interact with the program installation option. 

7 When done specifying the program information, click Next.  

8 Click Next on the Requirements page. 

9 Review the summary and click Next to create the package. 

Sending the Package to a Distribution Point 

To send a copy of the package to a distribution point, right-click the package of interest and click 
Distribute Content in the context menu. Use the Distribute Content Wizard to specify a 
distribution point to which you want to send the package.  
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Please make sure that the distribution point is properly configured as described in the Configuring 
a Distribution Point section. 

Deploying Parallels Desktop 

To deploy Parallels Desktop: 

1 In the Configuration Manager console, right-click the package and then click Deploy in the 
context menu. The Deploy Software Wizard opens.  

2 On the General page, click the Browse button next to the Collection field and select the 
collection containing the desired Mac resources (e.g. All Mac OS X Systems). Click OK and 
then click Next. 

3 On the Content page, verify the distribution point info and click Next. 

4 Click Next on the Deployment Settings page. 

5 On the Scheduling page, specify the schedule for this deployment. Click New to specify the 
assignment schedule. When done, click Next. 

6 Use the default values on the rest of the wizard pages and complete the wizard. 

The package will be advertised to Macs in the specified collection and will be distributed to them 
according to the schedule that you specified. 

See also Viewing the Status of a Package (p. 94) for the information on how to see the package 
distribution results. 

Deploying SCCM Client in Windows Running in a 
Virtual Machine 
If you are using Parallels Desktop for Mac Business Edition in your organization to run Windows on 
Macs, you can manage Windows running in a virtual machine using the native SCCM functionality. 
In order to do so, you need to install the Configuration Manager client software in a Windows virtual 
machine as described below. 

The native Configuration Manager client software can be deployed to Windows virtual machines 
using the Parallels Mac Management software distribution feature. The steps are as follows: 

1 Configure a distribution point. 

2 Create a software distribution package. 

3 Create a program. 

4 Send the package to the distribution point. 

5 Deploy the software. 
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The rest of this section describes how to create a software distribution package (step 2 in the list 
above) and a program containing instructions to install the client software in Windows (step 3). The 
rest of the steps have no specific requirements and are performed normally. 

Prerequisites 

Before creating a package, verify that the following requirements are met: 

• Windows running in a Parallels virtual machine is a member of the same domain as the 
Configuration Management site. 

• Windows has Parallels Tools installed. 

Creating a Software Distribution Package 

A software distribution package is a container for an application, file, or information that need to be 
applied to client computers. In this instance, the package will contain the Configuration Manager 
client software and a special file containing command-line instructions that you have to create prior 
to creating a package. 

To create a command line file, on the computer running the Configuration Manager console, 
navigate to the C:\Program Files (x86)\Microsoft Configuration 
Manager\Client directory. The directory should contain the Configuration Manager client 
software. Create a text file in the directory and name it install_agent_for_vm.cmd. Copy and 
paste the following instructions into the file: 

ccmsetup /noservice SMSSITECODE=<sitecode> CCMDEBUGLOGGING=1 
CCMENABLELOGGING=TRUE CCMLOGLEVEL=0 SMSDIRECTORYLOOKUP=NOWINS SMSMP=<mp 
hostname> 

The command line above uses two variables: <sitecode> and <mp hostname>. Substitute the 
variables as follows: 

• <sitecode> — substitute with the Configuration Manager site code. 

• <mp hostname> — substitute with the management point hostname. 

Create a distribution package and a program as described in the Software Distribution section. 
When creating a package, specify the Configuration Manager client agent directory as the source. 
When specifying the command line for a program, use the following line: 

:::osname=^Windows.*$!vmname=^.*$!checkversion=%SYSTEMROOT%\CCM\LSInter
face.dll|4.0.6487.2177!cmdline= install_agent_for_vm.cmd 

When the package is created, send it to a distribution point and specify the deployment settings. 
See Software Distribution (p. 90) for details. 
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Managing Windows Virtual Machine 

After you install the Configuration Manager client agent in a Windows virtual machine, the machine 
can be managed from the Configuration Manager console. Please note that depending on the 
networking mode used by the virtual machine, some of the standard SCCM management functions 
may not work. Please read the explanation below. 

A Parallels virtual machine can be configured to operate in one of the following networking modes: 

• Host-only. This networking mode completely hides the virtual machine from the outside world, 
so it cannot be managed by the Configuration Manager.  

• Bridged. This mode makes the virtual machine appear on your local network and the Internet 
as a standalone computer, so it can be fully managed by the Configuration Manager just like a 
physical Windows machine.  

• Shared. A machine that operates in this mode has full network access, but cannot be 
accessed by other computers on your network. This means that the Configuration Manager 
features that need to connect to the virtual machine will not work. For example, the Remote 
Tools feature will not work. However, the SCCM client agent running in a virtual machine can 
communicate with the Configuration Manager, so features like software distribution, compliance 
settings, hardware and software inventory will work. In general, if a management task is initiated 
and performed by the client agent, it will work. If a task is initiated on the Configuration Manager 
site and then tries to connect to the client agent running in a virtual machine, it will not work. 

To set the networking mode for a Parallels virtual machine, open the virtual machine in Parallels 
Desktop, select Virtual Machine in the Parallels Desktop menu, and click Configure. In the virtual 
machine configuration dialog, click the Hardware tab and then select Network 1 (or the network 
adapter of interest) in the list. Use the Type drop-down list box to set the network type. 

Providing Remote Assistance to Mac Users 
The Remote Assistance feature allows a system administrator to temporarily connect to a remote 
Mac computer and correct any problems on it if necessary. A remote connection can be 
established right from the Configuration Manager console with both managed and unmanaged 
Macs. 

To use the Remote Assistance feature, open the Configuration Manager console, find a Mac that 
you want to connect to and right-click it. In the context menu, point to Parallels Management 
Tools, and click one of the following connection options: 

• Connect via VNC. This option uses the Virtual Network Computing graphical desktop sharing 
system, which lets you remotely control the OS X desktop. 

• Connect via SSH. This option uses the Secure Shell (SSH) protocol to access a shell account 
on a remote Mac and execute commands in OS X. 
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Parallels Mac Management uses third-party VNC and SSH client utilities that are installed in 
Windows automatically when you install the Configuration Manager Console Extension component. 
A VNC server and an SSH server are included in every edition of OS X and are installed on a Mac 
by default. The following describes how to set up and use each connection option. 

Connect via VNC 

Before using this feature, the OS X Remote Management service must be enabled on each 
individual Mac. 

To enable OS X Remote Management: 

1 Log into a Mac. 

2 Open System Preferences. 

3 Choose View > Sharing, or click Sharing. 

4 In the Service list, select Remote Management and enable it by selecting the On checkbox. 

5 Click the Computer Settings button and then select the VNC viewers may control screen 
with password checkbox.  

6 Choose a VNC password and enter it in the field provided. You will later use the password to 
establish a VNC connection with the Mac. Whether you choose the same VNC password for all 
Macs in your enterprise (for simplicity) or a unique password on each Mac depends on your 
security policies. 

7 Click OK. 

8 Close System Preferences. 

When you select the Connect via VNC option in the Configuration Manager console, the VNC 
viewer application starts and asks you to enter the Mac user ID and the VNC password. If the 
credentials are valid, a window is displayed where you can remotely control the OS X desktop. 

Connect via SSH 

Before using this feature, the SSH service must be enabled on each individual Mac. 

To enable SSH in OS X: 

1 Log into a Mac. 

2 Open System Preferences. 

3 Choose View > Sharing, or click Sharing. 

4 In the Service list, select Remote Login and enable it by selecting the On checkbox. 

5 Close System Preferences. 
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When you select the Connect via SSH option in the Configuration Manager console, the SSH 
client application starts and asks you to enter the Mac user ID and password. If the credentials are 
valid, an SSH window opens where you can type and execute commands in OS X. 

Problem Reporting and Monitoring 
The problem reporting functionality helps you to gather system information for the Parallels 
Configuration Manager Proxy, Configuration Manager Console Extension, and managed Mac 
computers. The collected information can then be sent to Parallels Support. The following 
subsections describe how to use the Parallels Mac Management problem reporting tools and 
utilities. 

Sending Problem Reports Using Configuration Manager Console 

To generate a report and send it to Parallels Support: 

1 In the Configuration Manager console, navigate to the Mac you're having a problem with (or any 
Mac if you can't pinpoint it), right-click it and select Parallels Management Tools > Send 
Problem Report.  

2 In the Problem Report for Parallels Mac Management for Microsoft SCCM dialog, type a 
message that will be appended to the report and then click Send Report.  

3 A window with a progress bar will open informing you of the information gathering progress.  

The problem report data gathering consists of the following steps (transparent to the user): 

1 The Configuration Manager Console Extension information is collected and is sent to the 
Parallels Configuration Manager Proxy together with the selected Mac identifier. 

2 The Parallels Configuration Manager Proxy collects its own data and then requests the data 
from the specified Mac computer.  

3 The Parallels Mac Client collects its data and sends it back to the Configuration Manager Proxy. 

4 The Configuration Manager Proxy merges individual reports into a single one and sends it to 
Parallels Support. 

The final report will contain combined information gathered from all three components: Parallels 
Configuration Manager Proxy, Console Extension, and the Mac that was selected. After the 
problem report is sent to Parallels, a dialog will open displaying the report ID.  If you would like to 
request help with the issue, you can submit a ticket to Parallels Support and include this ID for 
reference. 

If you receive an error while using the reporting feature, make sure that the Configuration Manager 
Proxy and the Mac are running and accessible. If for some reason you cannot start or access the 
Configuration Manager Proxy or the Mac, you can use the available standalone reporting utilities, 
which are described in the following section. 
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Sending Problem Reports Using a Standalone Reporting Utility 

You can also send a problem report using a standalone reporting utility. Compared to the 
Configuration Manager console reporting feature, this utility will collect information for individual 
Parallels Mac Management components. For example, if you run the utility on the computer where 
the Parallels Configuration Manager Proxy is installed, the information will be gathered for the 
Configuration Manager Proxy only. If you run it on the computer where the Configuration Manager 
Console Extension is installed, the information will be gathered for the Console Extension. If both 
components are installed on the same computer, both will be included in the report. 

To run the utility, go to Start > Apps > Parallels and click the Send Problem Report application. 
The Send Problem Report dialog opens and the data gathering process begins. Once the report 
is generated, a message is displayed in the dialog specifying a temporary location on the local hard 
drive where the report file was saved. In the dialog, do one of the following: 

• Click the Send button to send the report to Parallels Support. After the report is sent, a 
message box containing the problem report number is displayed. You can use this number for 
future reference. The report file is automatically deleted from the temporary location. 

• Click Cancel to close the dialog without sending the report. If the utility is run on the computer 
where the Parallels Configuration Manager Proxy is installed, the report file will be forwarded to 
Configuration Manager Proxy, which will notify the Problem Monitor about it. You can then use 
the Problem Monitor to view the report summary and to send it to Parallels Support. For the 
information about Problem Monitor, see Using Problem Monitoring Utility (p. 151). If the utility 
is run on the computer where only the Configuration Manager Console Extension is installed, 
the report file will be deleted from the temporary directly and no other actions will be performed. 

Sending Problem Reports from Parallels Mac Client 

A reporting utility is installed on a Mac computer during the Parallels Mac Client installation. To run 
the utility, open System Preferences and then click Parallels Management (if your System 
Preferences are organized by categories, it is located in the Other category). For more information 
about using the utility, see Sending Parallels Mac Client Problem Report (p. 52). 

Using Problem Monitoring Utility 

Parallels Mac Management for Microsoft SCCM provides a utility that allows you to monitor the 
system in real time for possible problems. The utility is installed together with Parallels Mac 
Management and can be accessed on computers where the Parallels Configuration Manager Proxy 
or the Configuration Manager Console Extension are installed. 

The problem monitor runs in the background with a notifier in the Windows taskbar notification area 
(also called the "system tray"). It receives problem report notifications from the Configuration 
Manager Proxy and notifies the IT administrator when the reports are available. The following list 
describes how the monitor interacts with the Configuration Manager Proxy and the administrator: 
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1 If there's a problem with Parallels Mac Management, the Parallels Configuration Manager Proxy 
generates a report, saves it to a local file, and sends a notification to the problem monitor that a 
new report is available. 

2 The problem monitor receives the notification and displays a balloon tip in the notification area 
informing the administrator of a new report. 

3 The administrator can open the problem report list, which is populated with the names of the 
available reports and some basic info about them. 

4 The administrator can then send a report to Parallels Support, delete it, or close the list and 
return to it later. 

The rest of this section describes how to use the problem monitor. 

Starting and Stopping the Problem Monitor 

The monitor starts automatically after you complete the Parallels Mac Management installation. It 
also starts automatically when the computer is rebooted and a user logs in to Windows. If the user 
is not authorized to access the computer where the Parallels Configuration Manager Proxy is 
running, a dialog is displayed asking the user to enter a user name and password. After the 
problem monitor is connected to the Configuration Manager Proxy, it adds a notifier to the taskbar 
notification area.  

To terminate the problem monitor, right click its icon in the notification area and select Exit from the 
context menu. To manually start the monitor, go to Start / Apps / Parallels and click Problem 
Monitor. When the monitor starts, it immediately requests problem report information from the 
Configuration Manager Proxy. If there are new problem reports, a balloon tip is displayed. 

Receiving Problem Monitor Notifications 

By default the problem report icon in the notification area is hidden. To make it always appear, 
right-click the notification area and select Customize notification icons in the context menu. 
Change the behavior of the Problem monitor utility to "Show icons and notifications". 

Depending on the problem monitor status, its icon will be one of the following: 

•  indicates that there are no new problem reports. 

•  indicates that one or more new problem reports are available. 

•  indicates that the problem monitor cannot communicate with the Parallels Configuration 
Manager Proxy. This can happen if the Configuration Manager Proxy is down or if there's a 
network problem. 

The problem monitor communicates with the Configuration Manager Proxy every one minute. If 
there's a new problem report, the proxy notifies the monitor. Once the notification is received, the 
problem monitor displays a balloon tip in the notification area and its icon changes accordingly. 
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Viewing the Problem Report List 

To view the problem report list, click the balloon to open the Problem Reports dialog. If the 
balloon is not currently displayed, right-click the problem monitor icon and select Show Problem 
Reports from the context menu (or you can simply click the icon). 

Each row in the list contains information about an individual report and has the following columns: 

• Created — contains the date and time when the report was created. 

• Proxy info — if set to "Yes", indicates that the report contains the information related to the 
Parallels Configuration Manager Proxy. 

• Mac info — if set to "Yes", indicates the the report contains the information related to a 
managed Mac computer. 

• Description — specifies whether the report was generated automatically or manually by a user. 

If there are no problem reports on the server, the list will be empty. 

To perform an action on a report, select the report of interest from the list and click one of the 
available buttons: 

• Click Send to send the selected problem report to Parallels Support. After the report is sent, it 
is removed from the server on which it resides. 

• Click Delete  to delete the selected report from the list and the server on which it resides. 

• Click Close to closes the dialog. The reports will remain in the problem monitor report list and 
the report files will remain in their original locations. 

Viewing the Problem Report Activity Log 

The problem monitor maintains an activity log, which contains the information about the operations 
that were performed on the reports. To view the problem report activity log, right-click the problem 
monitor icon in the notification area and select Problem Reports Log from the context menu. The 
Problem Report Operations Log dialog opens. Each entry in the log describes an individual 
operation that was performed on a report. This is a read-only information provided as a reference. If 
a report operation included sending it to Parallels Support, the entry will include the report ID, which 
can be used when following up on the report with Parallels Support. 

Tracking Apple Warranty Status 

Parallels Mac Management allows you to track the Apple warranty status of each enrolled Mac. The 
warranty information is collected when a Mac is assigned to the Configuration Manager site and is 
saved in the Configuration Manager database. The database record is then updated according to 
the hardware inventory schedule. 

Note: To collect the Apple warranty information, make sure that Hardware Inventory is configured 
properly. See Configuring Inventory Settings for details. 
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To view the Apple warranty information for a specific Mac: 

1 In the Configuration Manager console, navigate to the collection containing your Mac 
computers. 

2 Right-click the Mac of interest and select Start > Resource Explorer in the context menu. 

3 In the Resource Explorer window, expand the Hardware node and click Apple Warranty 
Info. 

The Apple warranty info is displayed in the right pane and contains the following: 

• Serial Number — the Mac's serial number. 

• Warranty Expires — the warranty expiration date. If a Mac is out of warranty, this column will 
not be shown. 

• Warranty Status — the Apple warranty status. If the Mac is out of warranty, the status will be 
"Out of Coverage". 

Parallels Mac Management also creates a report containing the Apple warranty information for all 
managed Mac computers. The report can be viewed in the Configuration Manager console at the 
following location: Monitoring / Reporting / Reports / Hardware General / Apple Warranty Info. 

The Apple Warranty Info report contains the following information: 

Item Description 

Name  Resource name (same as the device name in the device collection). 

Resource SCCM resource ID. 

Serial Number Mac's serial number. 

Status Apple warranty status. 

Expiration Date Apple warranty expiration date. 

Last Update The date on which the warranty information was last updated. 

 

Initiating Policy Retrieval from SCCM 
Managed Mac computers download client policies from Configuration Manager automatically 
according to a schedule. There may be a need to download the latest policy before the scheduled 
download occurs. This is especially helpful when you test or debug something. Policy retrieval can 
be done from an individual Mac computer as described in the Initiating Policy Retrieval from a 
Mac section (p. 51). The functionality described here allows you to initiate policy retrieval for 
multiple Mac computers from the Configuration Manager console. 

To initiate policy retrieval from the Configuration Manager console:  
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1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Device Collections.  

2 You can initiate policy retrieval for the entire collection or for selected Mac computers: 

• To select individual Mac computers, double-click the collection containing your Macs and 
then select the desired computers. 

• To initiate policy retrieval for the entire collection, simply select the collection without 
opening it (alternately, you can navigate to Overview / Devices and select the collection in 
the left pane). 

While the collection or individual Macs are selected, right-click on them and then click Parallels 
Management Tools > Machine Policy Retrieval and Evaluation Cycle in the context menu. 

3 The Requesting Mac Clients to Download Policies dialog opens and the policy retrieval 
initiation operation begins automatically. The progress bar informs you of how many Macs have 
been processed.  

4 While the operation is in progress, you can hide the dialog by clicking the Hide button or by 
simply closing the dialog. The policy retrieval operation will continue to run in the background. If 
you want to cancel the operation, click Cancel. 

5 You can initiate another policy retrieval operation while the current operation is still in progress. 
To do so, simply repeat the steps above. The additional Macs that you select this time will be 
added to the list of the currently processed Macs and the operation will continue uninterrupted. 

6 When all Macs are processed, you can view the results of the operation by clicking the Details 
button. If the button is disabled, it means that all Macs were processed successfully. This 
means that the policy retrieval operation has been initiated on all selected Macs. If the button is 
enabled, clicking it displays the list of Macs that the Parallels Configuration Manager Proxy was 
unable to connect to. The Status column of the list will contain one of the following:  

• Offline — the Mac is turned off or unreachable. 

• Connection refused — the Mac was reachable but the connection was refused by it. 

• No client installed — the Mac doesn't have the Parallels Mac Client installed on it. 

• Not a Mac — the resource is not a Mac computer. 

You can sort the list by Resource Name or Status by clicking the corresponding column 
header. 
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Log Files in Parallels Mac Management for 
Microsoft SCCM 
Parallels Mac Management maintains its own log files which capture information about its 
processes. The log files are created and maintained for each component including Parallels 
Configuration Manager Proxy, Configuration Manager Console Extension, and clients running on 
individual Mac computers. Some information about Parallels Mac Management processes is also 
recorded in the System Center Configuration Manager log files. You can use the information 
contained in the log files to help you troubleshoot issues that might occur in the Parallels Mac 
Management for Microsoft SCCM.  

Parallels Mac Management for Microsoft SCCM Log Files 

The Parallels Mac Management log files are located in the following directories: 

• Windows computer running Parallels Configuration Manager Proxy: %Windir%\Logs ; 
%Windir%\Logs\pmm 

• Windows computer running Parallels OS X Software Update Point: %Windir%\Logs\pmm 

• Windows computer running Configuration Manager console: %Windir%\Logs 

• OS X (Parallels Mac Client): /Library/Logs/ 

The following table describes the Parallels Mac Management for Microsoft SCCM log files: 

C H A P T E R  5  

Appendices 
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Component Log File Name Log File Description 

pma_setup.log This log file is created during the SCCM Proxy 
installation. It contains information about the 
installation procedures and the changes they 
make to the system.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 

pma_isv_proxy_config.log This log file is created and updated every time 
the SCCM Proxy configuration utility is run. It 
contains information about the configuration 
parameters selected by the user (SMS 
Provider, service account name, etc.) and the 
results of the configuration operations. 

pma_isv_proxy_service.log This is the main SCCM Proxy log file. It is 
updated as needed while the SCCM Proxy 
service is running. It contains information 
related to the SCCM Proxy operations such 
as starting/stopping the service, reading 
various system properties, starting or 
stopping Mac management utilities and 
others.  

pma_discovery.log This log file is updated every time the Parallels 
Network Discovery runs. It contains 
information about the discovery itself 
(processes started, subnets searched, etc) 
and the information about discovered Mac 
computers, including IP address, hostname, 
MAC address, whether the Client installation 
was initiated on a Mac, and other info. 

Parallels Configuration 
Manager Proxy 

pmm_cep_master_service.log This log file belongs to the Parallels Customer 
Experience Program module. The log is 
updated when the corresponding service 
collects information and generates reports 
about the system. 

Parallels OS X Software 
Update Point 

pmm_sup_service.log This log file belong to the Parallels OS X 
Software Update Point component. it is 
updated when the corresponding service 
performs any of its operations. 

SCCM Console Extension pma_setup.log The SCCM Console Extension component 
has just one log file: pma_setup.log. The file 
contains information about the component 
installation procedure.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 
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pma_agent.log This is the main client software log file, which 
contains information about the client 
operations. The file is updated when the Mac 
Client communicates with SCCM Proxy 
and/or performs actions on the Mac 
computer on which it is running. 

pma_agent_ui.log This log file is updated when the client 
installation and registration utilities are run on 
the Mac by a user.  

The file also records information when an 
operation is performed on the Mac that is 
user-specific. An example of such an 
operation is applying a Mac configuration 
profile (a profile is applied for each individual 
Mac user if more than one user exists). 

Please note that if a Mac user doesn't have 
privileges to write to the /Library/Logs 
directory, the log file will be created in the 
/Users/<user_name>/Library/Logs directory. 

Parallels Mac Client 

 

pma_agent_uninstaller.log This log file is created when the client is 
uninstalled from the Mac computer. 

System Center Configuration Manager Log Files 

Some of the Parallels Mac Management process information is recorded in the SCCM log files. You 
may examine these files in addition to the log files described above. Please note that SCCM creates 
these files on the fly and not all of them may actually exist. 

The following table describes the Site Server log files which are located in the 
<SCCM_InstallationPath>\LOGS folder. The files may contain information about the SCCM 
Proxy component.  

Log file Log file description 

Colleval.log Records activities when collections are created, changed, and deleted by the 
Collection Evaluator. 

Dataldr.log Processes Management Information Format (MIF) files and hardware inventory in 
the Configuration Manager database. 

Ddm.log Saves DDR information to the Configuration Manager database by the Discovery 
Data Manager. 

Distmgr.log Records package creation, compression, delta replication, and information 
updates. 

Offermgr.log Records advertisement updates. 

Offersum.log Records summarization of advertisement status messages. 

Policypv.log Records updates to the client policies to reflect changes to client settings or 
advertisements. 

Smsprov.log Records WMI provider access to the site database. 

statesys.log  Records the processing of state system messages. 
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The following table describes the Management Point log files, which are located in the 
%ProgramFiles%\SMS_CCM\Logs folder. The files may contain information about the SCCM 
Proxy component. 

Log file Log file description 

MP_CliReg.log Records the client registration activity processed by the management point. 

MP_Ddr.log Records the conversion of XML.ddr records from clients, and copies them to the 
site server. 

MP_Framework.log Records the activities of the core management point and client framework 
components. 

MP_GetAuth.log Records the status of the site management points. 

MP_GetPolicy.log Records policy information. 

MP_Hinv.log  Converts XML hardware inventory records from clients and copies the files to the 
site server. 

MP_Location.log Records location manager tasks. 

MP_OOBMgr.log Records the management point activities related to receiving OTP form a client. 

MP_Policy.log Records policy communication. 

MP_Relay.log  Copies files that are collected from the client. 

MP_Retry.log Records the hardware inventory retry processes. 

MP_Sinv.log Converts XML software inventory records from clients and copies them to the site 
server. 

MP_SinvCollFile.log Records details about file collection. 

MP_Status.log Converts XML.svf status message files from clients and copies them to the site 
server. 

The following table describes the Admin UI log files, which are located in the 
<SCCM_InstallationPath>\AdminUI\AdminUILog directory. The files may contain 
information about the Configuration Manager Console Extension component. 

Log file Log file description 

ResourceExplorer.log Records errors, warnings, and information about running the Resource Explorer.  

SMSAdminUI.log  Records the local Configuration Manager console tasks when you connect to the 
Configuration Manager site. 

Parallels Mac Management for Microsoft SCCM Crash Dumps 

In addition to log files, crash dumps may be generated if a Parallels Mac Management component 
terminates abnormally. The crash dumps are generated for the Configuration Manager Proxy 
component and for Parallels Mac Clients running on individual Macs. Please note that crash dumps 
may not be created every time a component crashes. If a dump doesn't exist in the directories 
specified below, it can be found in the problem report, which will be generated instead. 

The crash dump file locations are: 
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• Parallels Configuration Manager Proxy: 
%ALLUSERSPROFILE%\Microsoft\Windows\WER\ReportQueue\AppCrash_pma_isv
_proxy_*, where AppCrash_pma_isv_proxy_* is the name of a directory containing the 
crash dump files (the name is appended with a unique suffix for each dump). 

• Parallels Mac Client: /Library/Logs/CrashReporter/pma_agent*.crash, where 
pma_agent*.crash is the name of the directory containing the files (the asterisk character is 
substituted with a unique dump identifier). 

Changing Log File Rotation Limits 

About Log File Rotation 

Parallels Mac Management for Microsoft SCCM implements log file rotation that ensures that the 
log files don't grow in size indefinitely. The amount of data contained in an individual log file and the 
total size of all logs are kept at a reasonable limit. Log file rotation is enabled by default.  

Parallels Mac Management for Microsoft SCCM consists of a number of executables including 
services, graphical user interface, and utilities. Each executable creates its own log file named 
<exec_name.log>, where "exec_name" is the executable file name. The following table lists 
Parallels Mac Management executables and their corresponding log file names and locations: 

Executable Name Operating System Log File Name and Path 

pma_isv_proxy_service Windows %Windir%\Logs\pma_isv_proxy_service.log 

pma_isv_proxy_config Windows %Windir%\Logs\pma_isv_proxy_config.log 

pma_discovery Windows %Windir%\Logs\pma_discovery.log 

pmm_cep_master_service Windows %Windir%\Logs\pmm\pmm_cep_master_service.log 

pmm_sup_service Windows %Windir%\Logs\pmm\pmm_sup_service.log 

pma_problem_monitor Windows %Windir%\Logs\pma_problem_monitor.log 

pma_report_tool 
Windows 

OS X 

%Windir%\Logs\pma_report_tool.log 

/Users/<user_name>/Library/Logs 

pma_agent OS X  /Library/Logs/pma_agent.log 

pma_agent_ui OS X /Library/Logs/pma_agent_ui.log 

A log file is populated with data when an executable is running and performing its tasks. When the 
size of a log file exceeds a predefined limit, the file is archived and a new empty log file is created in 
its place. This creates a log file rotation set consisting of the current log file and archived files. A log 
file rotation set is managed using the following rules: 

• Log files are archived using the zlib compression library. 

• The archived files in the set are named as follows:  

<exec_name.1.log.gz>, <exec_name.2.log.gz>, <exec_name.3.log.gz>, etc.  
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The <exec_name.1.log.gz> file is the most recently archived log segment. The file with the 
largest sequential number in its name is the oldest. When the current log file is archived, it is 
named <exec_name.1.log.gz>. The existing archives are renamed by incrementing the 
sequential number in their names by 1. The maximum number of files in a rotation set can be 
configured (see Changing Log File Rotation Limits below). When the number of files exceeds 
the predefined limit, the oldest file is deleted. 

• Rotation of each log is performed independently from other logs. 

Changing Log File Rotation Limits 

Log file rotation limits are configured similarly on both Windows and OS X computers. The following 
rules apply when specifying the limits: 

• Log file size limit. The default value is 1 MB (specified in bytes). The minimum allowed value is 
200 KB. The maximum allowed value is 4 MB. If a value is not set, the default value is used. If 
the specified value falls outside the min/max interval, the minimum or the maximum value is 
used respectively. 

• Maximum number of files in a rotation set. The default value is 10. The minimum value is 1. 
The maximum value is 20. If a value is not set, the default value is used. If the specified value 
falls outside the min/max interval, the minimum or the maximum value is used respectively.  

On Windows computers the log rotation limits are stored in the system registry. To modify the 
limits: 

• Run "regedit" and search for HKEY_LOCAL_MACHINE\SOFTWARE\Parallels\Parallels 
Management Suite for Microsoft SCCM\Preferences. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter.  

On OS X computers, the log rotation limits are stored in the 
/Library/Preferences/com.parallels.pma.agent.plist file. To modify the limits: 

• Open the com.parallels.pma.agent.plist file in a text editor. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter. 

Parallels Mac Management Database 
When Parallels Mac Management for Microsoft SCCM is installed, it creates its own SQL Server 
database on the primary SCCM site to store security data such as recovery keys, certificates, and 
other.  
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The database name is constructed using the following syntax: 

PMM_<site_name> 

Where, PMM_ is used as-is and <site_name> is the name of the primary SCCM site. 

At the time of this writing, the database is used to store the FileVault 2 disk encryption information 
and recovery keys. Other security related data may be stored in the database in the future. 

The system administrator should backup the database regularly in order to ensure the data safety. 
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